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Media Composer versions covered here may include the simple Title Tool, the Marquee Title 
Tool (for complex 3D animated titles but no longer supported after 2018) and the Avid Ti-
tler+ which can be used for idents, straps, lower-thirds, rolling and crawling titles and simple 
animations. The old Title Tool and Marquee are not available in 2020 and later releases running 
on Mac OS 10.15.x (Catalina). Titler+ is the only one of the three that can be used for titles 
larger than full HD. Here we’ll look at creating and modifying a static Titler+ effect, animating 
Titler+ effects with the Effect Editor, and saving and modifying Titler+ effect presets.

It’s not possible to make a standalone Titler+ effect title – the effect must be added to a segment 
in the Timeline. Either apply to a complete segment or use the Add Edit command to make a 
new segment in an existing clip. Alternatively, use Add Edit to create a segment on an empty 
video track above the background video. For ease of adjustment of the effect, switch to the Ef-
fects Workspace.

An icon for T+ can be found in the Timeline toolbar. Alternatively, open 
the Effect Palette and drag the Titler Plug-in on to the segment:

After adding the Titler+ effect, the Effect Editor will open. If the Effect Editor doesn’t open, 
make sure the correct video track is active and click the Effect Mode icon in the Timeline 
toolbar.

The Titler+ window will open with the current frame shown in the monitor. As you work on the 
title, you can play and preview in the monitor (but see comment below).

To preview in releases prior to 2019.12, only start and stop by clicking on the controls under the 
monitor – tapping the Spacebar will add unwanted letters. In later releases you can preview with 
the Spacebar.

Add Edits on clip Add Edits in Filler

13B     Avid Titler+



The Media Composer Companion13B•2

The T+ main controls may be opened and reopened from the icon in the Timeline toolbar. Title 
characteristics can be set here, before animating in the Effect Editor.

Both text and graphic objects can be created – each object becomes a layer in the title. Attributes 
can be turned on and off with the switches:      ‘Face’ is the main colour. ‘Edge’ is a border, if 
applied. ‘Frame’ puts a resizable graphic frame behind a text object. ‘Background’ fills the frame 
with a colour. The default is Background off, showing video behind the text or graphic shapes. 
Face and Shadow are on by default.

The defaults may be changed in the Titler+ settings. These are a User setting on a Mac. On Win-
dows, they can be found in Site>ACF/AVX Plugins settings. 

If you have several objects or text boxes, you can cycle through them using Next and Previous 
Layer buttons (this makes it easier to select the right object). Selected objects can be sent forward 
and back and grouped and ungrouped (see above)

Entering Text
The default text is white Arial. To enter text, select the 
Text tool, click anywhere in the monitor and type. When 
the text is correct, move the mouse off the text string and 
click carefully on the bounding box – corner handles will 
appear. You can now drag the boundary to reposition 
the text box – crosshairs appear as you drag. Dragging a 

corner handle scales the text proportionally. Dragging any other handle will distort the text.

Once selected, you can adjust the font, size, style and so on in T+ control panel (see next page). 

Effect Editor, monitor and Titler+ controls

Titler+ parametersSave as Default
Load Default settings

Add text
Add rectangle
Add ellipse
Bring to front
Send to back
Group
Ungroup
Previous layer
Next layer
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Several text characteristics can be modified, either by selecting the entire text string or 
selected words or letters. Don’t reselect the text button before editing existing text – if you 
do, a new text object will be added. Double-click to select a word. Triple-click to select all 
the text. Click and shift-click left or right to select several letters. All the parameters shown 

above can apply to single or multiple characters. It should be possible to click and drag on a 
value to adjust – if this isn’t working, overtype with a new value.

It can sometimes be difficult to select text by clicking in the 
monitor – try one of the Edit options in the Effect Editor:

Pair kerning can be adjusted by clicking be-
tween two letters, holding down Option/Alt 
and using the L-R cursor keys. Leading can 
only be adjusted in the Effect Editor.

Adding shapes
Simple graphic shapes can be added as layers to the title from buttons on the righthand side of 
the T+ control window (see previous page). Choose Ellipse or Rectangle. Graphic shapes can be 
modified in the same way as text objects.

Object priority
When there is more than one layer in your title, you may need to bring one to the front or send 
one to the back – do this from the buttons on the righthand side of the T+ control window (see 
previous page). Objects on different layers may be animated independently – carefully select the 
object before using the Effect Editor – the kind of layer, text or graphic, is shown in the Effect 
Editor.

Note that when adjusting the position of objects in the monitor, keyframes may be created in the Effect 
Editor, as you drag, in early versions. If you don’t plan to animate the effect, you may need to delete 
unwanted keyframes. In later versions, the automatic addition of keyframes is disabled until one 
keyframe is first added to a parameter manually.

Set Face colour     Set size    Set kerning (tracking)

Skew         Rotation   Opacity

Text characteristics

Two letters selected Two letters coloured

One letter coloured and rotated

One letter resized

Text string skewedPair kerning
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Colour and gradients
A single colour can be adjusted by double-clicking the appropriate colour 
bucket – a colour picker appears. It’s also possible to add gradients of up to four 
colours to text or graphic shapes and their shadows, edges and surrounding 
frames. Click the small box below and to the left of the main colour bucket to 
reveal four small boxes, each of which can be clicked to set a gradient colour.

Working with the Effect Editor

All the parameters set in the Titler+ control panel may be adjusted in the 
Effect Editor, sometimes more easily. Some parameters can only be adjusted 
here. Font characteristics (see left) apply to an entire text string or selected 
words or characters.

Face characteristics offer alternative ways to change the Face colour and gra-
dients.

None of these parameters have keyframe graphs.

Other characteristics that can be activated and 
adjusted in the Effect Editor without keyframe 
graphs include Underline, Edge, Shadow, Frame 
(a shape that surrounds the text) and Back-
ground (that will fill the frame). Twirl down an 
opener to reveal individual parameters.

Justification may be set for a selected text layer 
(see left).

The Edit tab (right) offers a number of ways of 
selecting objects. ‘Clear All’ really will remove 
everything (but can be undone).

Click ... to reveal gradient buckets

Two-colour gradient on face of text object

Colour picker (Windows)     Colour picker (Mac)
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It’s also possible to animate a number of parameters of the text or graphic objects, using the 
parameter sliders and keyframe graphs. Most of the parameters that may be keyframed can be 
found within the Layer tab. Each text or graphic object created becomes a layer – make sure you 
have the correct layer selected before adjusting. Layers can be selected by carefully clicking in the 
monitor, by using Next or Previous Layer options in the Edit tab of the Effect Editor, or using 
the object priority buttons either at top right of the Effect Editor, or in the Titler+ control panel.

Some of the terminology used is a little unusual, so to 
change the position of an object, select it in the monitor 
and open ‘Translate’ (Layer):

Other layer parameters that can be animated include Scale, Z Rotation, Skew and Origin. Ori-
gin is the centre of rotation and its initial location is determined by where in the frame the text 
or graphic object was created. There is no way of seeing the origin in the monitor, unlike Axis in 
a 3D Warp effect. X or Y rotation is not offered (as of 2020.6).

Selected object
Unselected objects
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Global parameters
Two Global parameters that can be keyframed are included – Foreground Level (opacity) and 
Crop:

These parameters affect all layers in the title effect.

Rolling and Crawling titles
A block of text may be turned into a rolling or crawling title 
by activating the Effect button found at bottom left of the 
Effect Editor. Options are Roll, Crawl, CrawlPg Left and 
CrawlPg Right. Roll scrolls the text up the screen. Crawl 
scrolls the text across the screen. The two other options 
move the entire text block across the screen.

It can be quite difficult to type in a large amount of text 
directly into the Titler effect, so consider creating the text in a text editor (Apple TextEdit or 
Windows Notepad) and copy and paste into Titler+. Adjust font, size and colour as required. 
Choose an effect option from the menu.

The parameter that moves a roll or crawl across the screen is Effect Position (see below). Start 
and end keyframes are set automatically.

To slow down a roll or crawl elegantly at the end, consider changing keyframe interpolation 
to Bezier. Move to the point you’d like to stop the movement (maybe on the last line) and add 
a keyframe. Copy the keyframe value (Cmd+C [Ctrl+C]) and paste on to the last keyframe. 

Effect menu                  Effect Position graph                            Rolling text block
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Change interpolation to Bezier and carefully adjust the 
dynamics to suit by adjusting the control handles.

Fade the title out either by adding keyframes to Foreground 
Level, using Fade Effect or a Dissolve ending at the last 
frame. Rolling and crawling titles will preview in real time 
but may need rendering, depending on the format of the 
project and media.

Modifying text in a roll or crawl
It’s quite difficult to modify text in a rolling or crawling title. Simply clicking in the text box 
will not work if the Effect is still active. Deselect the Effect button and the text can be edited 
but, depending on the number of lines or words, you may not be able adjust position suf-
ficiently to see the part you plan to edit ... and then you’ll have to reset position.

The way round this is to open the Caption parameter, which is found 
below the other Layer parameters. Text can be edited here (but first make 
sure the correct text object is selected in the monitor). When done, reacti-
vate the Effect parameter and view the results.

As mentioned earlier, do not use the Spacebar to attempt to start and stop 
a preview in the monitor in versions before 2019.12 – extra space charac-
ters will be added to your text. Use the Play or Play Loop buttons with the 
mouse, instead.

Although static Title+ effects play in real time, animated titles may require rendering, even 
though they display a green dot.

Saving titles as templates
A Titler+ title can be saved as an Avid effect template. Drag the title icon from the top left of the 
Effect Editor into a bin as usual. The template can be renamed and re-applied by dragging onto 
a clip or a short segment marked with Add Edits.

Add keyframe ...
   and copy value to last keyframe

Turn off before
editing text

Play                           Play Loop

Drag icon to bin
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Using video fill
From the 2019.12 release, it’s possible to change the fill colour of a title with moving video. Cre-
ate a title as normal, then return to the Edit Workspace. Double-click the title in the Timeline to 
show the nested elements:

Load the new video clip into the source monitor and patch source V1 to 
nested track V2 inside the title (ignore nested track V1):

Mark the nested track, I-O:

Now, overwrite the new video into the nested track. At this point, you won’t see any difference 
in the title’s appearance. Return to the Effects Workspace (or open the Effect Editor) and adjust 
the Video Fill Opacity (in the Global Foreground parameter). This parameter can be keyframed 
so it’s possible to mix from the original title graphic to the video. The default value for this pa-
rameter is 0%, so the video will not initially be visible.

You’ll find that the video replaces both the graphic 
fill (text colour) and the shadow, if there is one 
(see right). If you need a drop shadow behind the 
video, you can duplicate the title on to a lower 
track, change the text colour to black and offset 
this second title using the Horizontal and Vertical 
translate parameters (below).

Nested track V2

Video replaces title colour

Using two titles to create a fake shadow


